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Introduction

Among other things, the Marc 2021.2 release introduces new analysis options, solver performance improvements, contact
and GUI enhancements.

A new key feature of Marc 2021.2 is the possibility to perform classical stress-life and strain-life fatigue calculations in the
time domain. These are often used for the study of fatigue in metals but can also be used for other types of materials such
as plastics.

For planar and axisymmetric models, the node-to-segment contact algorithm has been enhanced by introducing the hybrid
contact algorithm, which improves the constraint algorithm for contact between meshed bodies and can for example be
applied to simulate complex rubber seal contact.

The MUMPS solver, with further improvements compared to Marc 2021.1, is now the default solver when preparing a
Marc analysis in Mentat. SMA materials can be applied to beam elements, structural solution quantities can be selected as
independent table variables and gaps in ATAS support by Model Sections have been closed. Various ease-of-use and GUI
completeness issues have been addressed and several defects associated with previous releases have been corrected.

Marc 2021.2 uses the same compiler version as Marc 2021.1. See List of Build and Supported Platforms - Marc 2021.2 Release for
more details. Marc 2021.2 requires the “Helium” release of MSC Licensing which uses FLEXIm 11.16.3.0. Please refer to
the Marc and Mentat: Installation and Operations Guide for more details.

Overview of New Functionality
The new functionality in Marc 2021.2 includes:

Marc
= Fatigue Enhancements:

 Darts of the CAEfatigue time domain capabilities are integrated in Marc now and the user can directly use
Mentat to prepare and launch advanced Fatigue analyses.

m Hybrid Contact for Planar and Axisymmetric Models:

* For planar and axisymmetric models, an extension of the node-to-segment (NTS) method is introduced which
is called the Hybrid Contact algorithm. This algorithm is aimed to improve complex contact scenarios between
meshed (deformable) bodies without the need for getting extra input from the user.

= MUMPS Solver Improvements:

 The limitations of the renumbering logic introduced in Marc 2021.1 have been removed. The singularity ratio
is now printed by default and available during Job Monitoring in Mentat. The MUMPS solver is now the
default in Mentat.

m Shape memory alloy (SMA) Model for Beam and Truss Elements:

¢ In this release, the SMA material model Thermo-Structural (2) has been made available for Beam and Truss

elements.
® Result Quantity as an Independent Table Variable:

 The coordinates, displacements and rotations of a node can be used now as independent table variables.
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m ATAS and Model Sections:
 Advanced Thermal Analysis Software (ATAS) is now supported by Model Sections.

Mentat

m Support new Marc functionality:
 The above-mentioned Marc features are all fully supported by Mentat.
® Improved Filter for Tables and Results File Quantity Section:

 The filters on the list of table variable types (Tables menu) and on the list of available result quantities (Job
Results menu) update the list automatically if the filter text is changed.

= .obj File Format for 3-D Graphics

e The WaveFront format, which is an open format for 3-D geometry definition, is now available for export in
Mentat; such files can be opened in various third-party viewers.

® Abaqus and Nastran Translator Improvements:
e The number of supported options has been increased.

More details can be found in the User's Guide, in the chapter called What's New along with examples to guide the user in
applying the new functionality.

Changes to Initial and Boundary Conditions in Mentat

State variables allow one to store the values of user defined quantities at the integration points of the elements. These values
are usually calculated by user subroutines. However, the first state variable of an integration point is reserved and contains
the temperature at the integration point. It is used (among others) to evaluate temperature dependent material parameters
at the integration points. In an analysis with a thermal pass, the first state variable cannot be prescribed using a boundary
condition, since it is calculated from the temperatures at the nodes of the element. To reflect this distinction between the
first and the other state variables, the State Variable boundary condition in Mentat has been removed and has been replaced
by two new boundary conditions: Element Temperature and User-Defined State Variable. Likewise, the State Variable
initial condition has been removed and has been replaced by two new initial conditions: Element Temperature and User-
Defined State Variable. The Element Temperature conditions can be used to prescribe the first state variable of an
integration point (the temperature) and are only available in analyses without a thermal pass. The User-Defined State
Variable conditions can be used to prescribe state variables 2 and higher and are available in any analysis. State Variable
initial and boundary conditions contained in existing models are automatically converted to the new types when the model
is opened in Mentat 2021.2.

Complex valued initial and boundary conditions, such as those used in harmonic analyses, can be entered either by
specifying the magnitude and phase, or by specifying the real and imaginary parts of the complex number. In previous
Mentat versions, if one would enter the magnitude and phase and then switch to real and imaginary input, the values
entered as magnitude and phase were interpreted as the real and imaginary values of the complex number which, given the
different dimensions of the phase and imaginary part, is usually not correct. In Mentat 2021.2, the four values are stored
separately in the Mentat model and can be changed independently of each other. Only two of these values will actually be
used in the analysis (either the magnitude and phase, or the real and imaginary parts, depending on which input style is
selected). Existing models are automatically converted to the new storage scheme when they are opened in Mentat 2021.2.
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List of Known Defects in the 2021.2 Release

For more details on fixed and corrected defects please visic: MSC Marc and Mentat Error List

Marc

Contact
MARC-7984

MARC-8766

MARC-10114

MARC-10533

MARC-11564
MARC-12637

MARC-12874

MARC-12555
MARC-13581
MARC-13683
MARC-15644

MARC-16923

When using node-to-segment contact in a coupled Thermal/Structural analysis, if a node contacts both a
surface with glued contact and a surface with touching contact, then there is incorrect heat transfer on the
touching face.

In analyses with global remeshing, high gradients in the solution (e.g. as seen in some thermal analyses)
may not be captured very accurately, which may cause noticeable differences between the solutions with
and without global remeshing.

In some cases, the segment-to-segment contact procedure with augmentation may report locally high
friction stresses, while the friction forces are correct.

In rare cases, if “Expanded Beam Post File” option is enabled via Job Results>Contact>Segment To
Segment Contact, while post processing with the default scale factor, extended beam geometry may not be
noticable.

For some specific linear perturbation jobs, results may vary significantly depending on the contact
algorithm used.

Selecting the Near Contact Distance post code may significantly increase the stress recovery time if the
specified near contact distance tolerance is very large.

If use is made of Geometric Bodies with Nodes, and such Geometric Bodies come into contact due to a
rotational movement, then the reported contact forces on these bodies might be incorrect (they typically
might show very large values).

When large sliding between the deformable and rigid body with segment-to-segment contact, contact area
may not get updated.

A beam-to-beam contact analysis using the node-to-segment algorithm may fail if nodal transformations
are used.

In some cases, the Version 2 Segment-to-Segment contact algorithm with default parameters may lead to
relative large penetration.

For a particular marc job with 2D contact analysis using deformable body and sheet body, penetration is
observed. If sheet body is converted to NURBS, the job runs to completion.

In rare cases, the segment-to-segment contact algorithm may show incorrect temperature results in case of
non-congruent meshes along the contact interface.


https://simcompanion.mscsoftware.com/infocenter/index?page=content&id=KI8008652
https://simcompanion.mscsoftware.com/infocenter/index?page=content&id=KI8008652
https://simcompanion.mscsoftware.com/infocenter/index?page=content&id=KI8008652

Material

MARC-15386

MARC-17222
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There are two Thermo-Structural Shape memory alloy models that are represented as Thermo-Structural
and Thermo-Structural (2). For the former, if a tension-unloading is applied, a strange drift might be seen
in the stress-strain response, which is aggravated when the material is undergoing repeated loading-
unloading cycles.

In a harmonic analysis using the PRF material model (multi-network model), the stiffness of the secondary
networks (viscoelastic and/or plastic) is currently not included in the stiffness matrix used in solving the
harmonic subincrements.

Global Remeshing

MARC-15283

MARC-15402
MARC-16902
MARC-17630

MARC-17717

Multi-Physics
MARC-12101

MARC-12699

MARC-12855

Changing element types during global remeshing may cause incorrect results (when performed after some
loading) or a program termination (also when done at the start of the analysis). This includes changing
from triangular elements to quadrilateral and vice versa. Some combinations work correctly, but there is
currently no check for invalid combinations. A workaround is to change the element type during pre-
processing instead, which is also a general recommendation.

For a job that uses old style input and undergoes remeshing during the cutback process, may lead to
incorrect displacement value. This issue is not observed if Table style input is used.

If a job fails in global remeshing on account of issues with the original geometry, the diagnostic message
is not very helpful.

Curvature control in automesh surface may not generate the mesh correctly for quad or mixed element
family.

A 2-D analysis involving global remeshing may crash instead of issuing a proper error message if the mesh
prior to remeshing is invalid.

The options INITIAL STATE and POINT TEMP cannot be used in the same analysis, even if INITIAL
STATE is not referring to the first state variable (temperate).

Prestate analysis does not work with thermal structural model of shape memory alloy. The stress and
volume fraction of martensite is not transferred in prestate analysis. However, it works fine only when we
use a structural model of shape memory alloy.

In the sequential thermal/structural analysis with multiple types of element, if post file reversion 13 is used
from thermal runs to structural run, structural analysis results may not be correct.
Workaround: Instead of post file revision 13, use default post file.

5
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Parallel Processing

MARC-8690 If a Marc model uses non-consecutive node and element numbering such that the ID’s are much larger
than the number of nodes and elements in the model, then the amount of memory required in a DDM
analysis is significantly larger than in a serial analysis.

MARC-12227 In rare cases, a Node-to-Segment DDM contact analysis using the RBE2 option may stop prematurely
with exit number 1004.

MARC-17645 The results of a DDM Current/Thermal analysis may depend on the number of domains.

User Subroutines

MARC-10057 In a segment-to-segment contact analysis, the nodal post code Contact Stress is not supported by user
subroutine NODVAR.

MARC-13066 User subroutine VSWELL doesn't get called in a viscoelastic analysis.

MARC-16034 If the user outputs, the IBODY numbers for a HEXA element in the UFILM routine to fort.99 file, it do
not match the numbers as defined in volume B. The numbers are usually off by 20. So instead of 1, the
IBODY number is represented as 21.

Loads, Boundary and Initial Conditions
MARC-12897 The TYING CHANGE option may not work correctly with the RBE2 option.

MARC-12870 If elements are deactivated during the former job, the Prestate option may fail with a misleading error
message.
“error: either element types are not supported or element type in ond job does not match that in 1** job”

MARC-14124 For a particular Job with table driven input, if load controlled meshed rigid body with initial velocity is
used, the job may exit with Exit 2008. With Old Style input, the job successfully runs to completion.

Other

MARC-10017 Writing iterative results to the postfile could change the simulation behavior in some cases, especially if
the analysis is unstable. Furthermore the post files with iterative results can not be used in the pre state,
axito3d, initial state and change state options.

MARC-11485 In rare cases, if the dynamic allocation of memory fails, Marc will stop prematurely without printing a
clear error message.

MARC-11881 If material orientation is defined using Cylindrical or a Spherical Coordinate System, the orientations may
not be retained.
Workaround: Define orientations using either edge or plane.

MARC-12171 The nodal post code External Pressure is not correct for 10-node tetrahedral elements. This does not affect
any other analysis results.

MARC-13950 For jobs with non positive definites, when run with CASI Solver, switches to Direct Solver (Solver 8).
MARC-13580 If user tries to submit the Marc job using DCOM on Win 10, it may not work.
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MARC-14946 Hydrodynamic bearing is not supported with table input.

MARC-15183 For a particular model, flowline conditions are not honoured completely. This is at least visible for some
duration of analysis.
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Mentat

General
MARC-5343

MARC-5408

MARC-8600

MARC-11210

MARC-11633
MARC-11918
MARC-13055

MARC-13643

MARC-13649

MARC-14892
MARC-15566

Preprocessing
MARC-10183
MARC-6598

Faceted surfaces can not be duplicated, neither using the commands in the Geometry & Mesh = Duplicate
menu, nor using the commands in the Geometry & Mesh > Symmetry menu.

The cross hairs option, which was available in Mentat Classic to provide guidance when picking items
from the graphics window and which could be activated by clicking the SHIFT key on the graphics
window, is not supported in the new Mentat.

The database function set_entry(), that returns the id of a specific entry of a set, does not function for sets
of type solid, solid_face, solid_edge and solid_vertex.

If *image_save_graphics command is used in a procedure file and executed in background using the -bg
option, the images are captured in black. If the command is used in foreground, it works correctly. This
behavior is seen Win10 OS.

Mentat creates negative geometry IDs after repeated BDF import. Such file when exported and run with
Marc eventually fails with Exit 13, *** error - no material assigned to element number ...".

When Mentat is invoked on UHD (Ultra High-Definition) resolution (3840x2160) screen, it may cause
icons to be displayed as extremely small. Further for few forms, the text too may appear very small.

In Main Menu >> Geometry and Mesh, if Mentat is not running in full screen mode, the options under
Operations menu may overlap each other.

In Marc 2019 FP1 and later releases, when using 3Dconnection space mouse at the end of each operation,
the model jumps a bit - like invoking unintended zoom. This issue is not seen until the user uses the zoom
option This works fine in Mentat 2019.

Workaround: Using FIT option improves this behavior temporarily.

In a particular installation on Windows 10 with Marc Mentat 2018.1 with Japanese installation,
""QWindowsFontEngine: :QWindowsFontEngine: GetTextMetrics Failed ()"" messages are issued
multiple times in mentat output console window. These messages do not impact any functionality/ usage
and are harmless.

Modifying menubar.xml and compiling main.msb may not work with default installation path.

For a Marc dat file that has parasolid files associated with it, when imported in Mentat and if the associated
parasolid files are not available, Mentat correctly issues the warning but mentat output console window
indicates the count of number of warning message as zero.

In Mentat, the internal pressure on element type 31 (pipe element) cannot be defined.

In 2-D models, Mentat allows one to apply initial conditions like Initial Temperature, Initial Velocity, etc.
on surfaces. However, this is not supported by Marc. Such initial conditions must instead be applied to
the nodes of the faces attached to the surfaces.
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MARC-4596
MARC-4544

MARC-3587
MARC-3511
MARC-2136
MARC-1622

MARC-13717
MARC-13465

MARC-12478

MARC-11230

MARC-17632
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Mentat does not support Geometric Properties for Electrostatic analyses to define for example, the
thickness of a shell. The workaround is to temporarily change the Analysis class to Thermal, create a
Thermal Geometric Property of the appropriate type for these elements and then change the Analysis Class
back to Electrostatic.

Mentat allows creating materials with identical names. This can be confusing when selecting a material.

Mentat does not support the Marc option to choose magnitude/phase or real/imaginary nodal output in
harmonics for the PRINT NODE option.

Multiple axes of rotation for Centrifugal loads are not supported within Mentat.
The General Traction distributed load type 21 is not supported within Mentat.
Mentat does not support the Foundation option for 2-node line elements.

Mentat is unable to control the prescribed displacement boundary conditions in a Modal Dynamics Load
case. This may results in problems with Design Optimization in a modal dynamics simulation.

If a meshed solid is scaled, then boundary conditions applied to the solid are lost.

Mentat records the dynamic viewing command with the view number, but doesn't record the graphics
window (such as Model, Table, Path Plot,etc.). So, in some cases the wrong graphics window may be used
when executing the procedure file.

Cohesive glue option is only available with thermal constraint. But still Mentat allows the user to set off
the radio button for thermal constraint giving the impression that cohesive glue option has been selected
without thermal constraint. This is only cosmetic error. When such analysis is run or if the Marc file is
exported, it correctly sets the cohesive glue with thermal constraint on.

The thickness direction of the composite element is defined using the orient option. In Mentat when
orientation is applied to an element using curves, Y and Z directions are not displayed correctly.

In rare cases, converting the edge of a Parasolid body to a NURBS curve may not work correctly.

9
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Post Processing
MARC-10509

MARC-10225
MARC-10126

MARC-8764

MARC-8114

MARC-5906

MARC-5748

MARC-5015

MARC-4622
MARC-1226

MARC-12559

MARC-11504

MARC-11355

If sample point data is tracked using the post file of a pure thermal analysis involving remeshing, then the
option Fixed Points In Space must be set. If this is not done, no warning message is given and an incorrect
sample point plot may be created.

Data collection for History Plotting does not function correctly if sub-incremental data has to be collected.

Model clipping by results scalar does not work when the nodal averaging of the results is turned off. Only
exterior faces of the visible elements are shown and internal elements do not show up at all.

If a report is created using the Report Writer for selected entities (nodes and/or elements) and over a list
of increments while post-processing a job with adaptive meshing, then no data will be reported for the
selected entities, unless they have been selected in the finite element mesh of the first increment in the list.
In that case, data will also be reported for subsequent increments in the list until the finite element mesh
changes. A workaround is to create a report of the current increment for the selected entities, or for all
entities over the increment list.

If the entities (surfaces, curves and points) of a trimmed geometric contact body are made invisible through
the command sequence Select Contact Body Entities / Make Invisible, then the trimming curves show up
again when skipping to an increment with a different mesh (due to remeshing). Workaround is to make
the contact body itself invisible, e.g. through the Model Navigator.

If Cutting Planes are defined in postprocessing and the extreme values of the quantity are assumed on the
cutting plane and not on the surface of the model, then these extreme values are not reflected in the legend.

When postprocessing jobs in which VCCT cracks are initiated during the analysis (i.e. not all cracks already
exist at the start of the analysis), then history plots involving crack related quantities, such as Energy
Release Rate, Accumulated Crack Growth and the Number of Fatigue Cycles, may be incorrect if the data
is collected in a range of increments in which a new crack has been initiated. The workaround is to collect
data from the increment in which the crack has been initiated to the last increment before the next crack
is initiated.

The automatically computed range of the current scalar or vector quantity, as shown in the Scalar Plot
Settings and Vector Plot Settings menus, respectively, is not updated automatically if one skips to a different
increment. The legend on the graphics window shows the correct range though. The menus can be
updated by pressing the Enter key once in the “Command” box of the Dialog, i.e. by entering an empty
command string.

In rare cases, a non-symmetric contour plot is shown for a symmetric problem.

The automatically computed value range for a vector plot of 3-D continuum elements may be wrong when
only the Edges on the Surface are being drawn.

If a restart analysis is performed using a restart file from an analysis where a geometric contact body has
been added (ADD RIGID option) and a continuous post file is requested, then this post file is corrupt and
does not show incremental results when opened in Mentat.

For a particular job, when post processing in Mentat, it is observed that the “Maximum Principal Value of
Stress is smaller than the “Minimum Principal Value of Stress”. When using “Translate” & “Off” in
Element Extrapolation Settings and Isolate Elements, this behaviour is not observed.

The option Draw Local Axes (Results > Model Plot > Beam Diagram Settings) can not be switched off
during post processing.
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MARC-11215 With different orientation of shell elements, nodal averaging result for “Principal value of Stress” values
may be incorrect.

MARC-10325 For a Marc run in progress on linux machine, if t16 file is accessed through Samba Server on Mentat in
Windows 10, *post_scan and *post_monitor works only for the increments which were already written to
the postfile at the time when it was accessed and not the ones that were writtend after the file was accessed.

Marc Writer

MARC-9714 If a Marc input file is created for a segment-to-segment contact analysis with a non-zero interference
closure, but without augmentation, Mentat will not issue an error message, although the Marc analysis will
stop with exit number 13.

MARC-8105 If old-style input is used, an incorrect input file may be written for a job that contains a harmonic load
case with a distributed load. Workaround is to use new-style (table-driven) input.

MARC-7996  If a model has multiple radiation cavities, each cavity should have its own boundary condition, instead of
assigning the same boundary condition to multiple cavities. However, Mentat will not issue a warning or
an error message in such cases.

MARC-7215  User defined point, curve and surface sets consisting of points, curves and surfaces of a geometric contact
body, or of points, curves and surfaces which are not used in the finite element analysis (i.e. do not have
mesh attached, are not used to define the material coordinate system of an Orientation, etc) can be written
to the Marc input file as empty sets and thus will show up in postprocessing also as empty sets for DDM
analyses using decomposition in Mentat.

MARC-5929 If a WELD FLUX boundary condition is not explicitly selected in a load case of a restart analysis, Mentat
does not write WELD PATH and WELD FLUX data into the Marc input file, causing Marc to stop
prematurely with exit number 77.

MARC-4047 Mentat does not write a correct Marc input file if two node, element, edge, face, point, curve, or surface
sets exist with the same name.

MARC-13681 When defining a centrifugal load in a model that consist only of axisymmetric model sections (without
any element in the model), the definition of the axis of rotation is not written to the *.dat file.

MARC-12459 Standard beam sections such as Rectangular, Circular, Elliptical, Square, Triangular, etc. are not written
into a Model Section file (as opposed to customised beam sections using Area, Ixx and Iyy).

Marc Reader
MARC-9765 The OP2 option is not supported.
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CAD
MARC-5655

MARC-8002

MARC-8660
MARC-16685

MARC-16755

Other

For some CAD models, the automatic feature removal options in the File > Import > General CAD As
Solid menu may fail. Workaround is to remove the features after import via the Defeature menu on the
Geometry & Mesh tab of the main menu.

The Holes and Pockets options in the Import = General CAD As Solids = Defeature Settings menu, that
allow one to select the types of holes that are to be removed when importing a CAD model, do not work.
If the Remove Holes/Pockets option is switched on, then all holes and pockets with a radius within the
given range are removed from the model.

On rare occasions, defeaturing may not work correctly for certain features, like chamfers, fillets, etc.

A particular igs file when read in Mentat and if “Switch to Solid without line” option is used, it causes
Mentat Program to terminate.

A particular 3D autocad file fails to import in Mentat.

MARC-7266 When using remote access (for example, VINC) to use Mentat on a Linux machine, creation of GIF movies

may fail; the image may appear mirrored.

MARC-9925 The Marc Movie program fails to import multiple RGB files at once.

MARC-14082 This is reported for a some third party tool with the customer which helps them create Marc input deck.

user is logged on"" in works fine. But if the toll is initiated using ""Run whether user is logged on or not"
the DCOM connection fails. Mentat with a procedure file works for both conditions.

This tool is typically run on a remote server and starts Mentat with option ""-bg"" and initializes a DCOM
interface. The tool executes the scheduled task. If the tool is initiated with the option ""Run only when

n
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List of Fixed Defects in the 2021.2 Release

For more details on fixed and corrected defects please visit: MSC Marc and Mentat Error List

Marc
General

MARC-14806

MARC-15159
MARC-17132

MARC-17430

Contact
MARC-17114

MARC-17429

Mesh Adaptivity

MARC-14678

MARC-16998

MARC-17281

MARC-17386

In an analysis with a Global-Local boundary condition where a Time Shift is used to retrieve the data from
the post file of the Global run, it was not possible to synchronize the Local time to the Global time (i.e.
the time at the start of the Local run was always zero). Now an option is available to perform such a time
synchronization for the Local run.

In rare cases, a file called fort.16 file was created if a Marc model contains the HDFPOST option, but not
the POST option.

If a Marc data file contains parentheses, then on Windows Marc would fail to start if the analysis involves
MPI (either because of DDM or MUMPS).

If an analysis is launched from within Mentat using a non-existing scratch directory (defined in Job
Properties > Run Job > Advanced Job Submission), the error message created by Marc was not written into
the log file, so that it looked like that the analysis was hanging (in the Run Job menu, the Status showed
Running without any further updates). Now such an analysis will finish with Exit number 8.

Nastran-style MPC generated using the MPCOUT command in Marc were not correct for tetrahedral
elements and caused the Nastran run to fatal out.

If beam elements used in a segment-to-segment contact analysis are incorrectly defined, instead of printing
an error message, the program could terminate prematurely.

Depending on e.g. the hardware being used or the condition of the problem, upon global remeshing finite
element meshes could be different, in rare cases leading to different exit messages (e.g. successful
completion versus a premature exit due to convergence issues). For planar and axisymmetric models, the
hybrid contact algorithm is found to improve the robustness and avoids such premature exits.

An analysis involving Joule heating, orthotropic materials with orientations and local adaptivity, gave
wrong results (or did not converge at all) upon mesh refinement.

If in a relatively large model (say over 50,000 nodes and elements) with local adaptivity boundary
conditions are applied to many nodes, the computational time required to evaluate the boundary
conditions (typically seen in the output file between “start of increment” and “start of assembly”) could be
very long.

Active nodes for finish temperature checks with adaptive multi-criteria based time stepping were not
determined correctly when nodal boundary conditions that are used in the analysis are applied on these
nodes.


https://simcompanion.mscsoftware.com/infocenter/index?page=content&id=KI8008652
https://simcompanion.mscsoftware.com/infocenter/index?page=content&id=KI8008652
https://simcompanion.mscsoftware.com/infocenter/index?page=content&id=KI8008652
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MARC-17387

MARC-17637

Materials
MARC-16340

MARC-17342

MARC-17356

MARC-17578

Multi Physics
MARC-16662

MARC-17280

MARC-17608

Material orientations were not transferred correctly from parent to child elements or viceversa for local
adaptive meshing with subdivision or coarsening.

In rare cases, Marc could stop prematurely during a Trimming load case.

For a Pyrolysis material, a new method called “User Defined” gives the opportunity to enter the effective
conductivity as a fixed value or a table depending on, for example, temperature or charred solid volume
fraction.

In a Mentat model that contains a streamline region used for the Streamline Pyrolysis Model and where a
model section is imported with an extra streamline region, then if the number of edges/faces defining the
region in the Mentat model was not correct, then the calculation of the pyrolysis (using the Streamline
Pyrolysis Model) was wrong for the region in the model section.

For the Vegter 2017 model, the R-values echoed in the output file were incorrect (this did not affect the
results).

When the material of 3-D solid elements uses any of the Barlat orthotropic plasticity models combined
with kinematic hardening, the results of the analysis could be incorrect.

For harmonic Magnetodynamic analyses with thick wire coils without terminals, a slow convergence
process could be observed, which could lead to wrong results if the convergence tolerance is not sufficiently

tight.

A coupled Magnetostatic/Structural analysis which uses the Maxwell Stress Tensor method could stop
prematurely if the model contains an RBE2 element.

In a magnetostatic analysis, Marc could give an incorrect warning message if a material orientation in a
cylindrical coordinate system is used.

Performance/Parallel Processing

MARC-16460

MARC-17348

Marc could terminate prematurely if a model in which nodes are attached to geometric points or to vertices
of CAD bodies is run using single input file DDM (i.e. with the decomposition in domains done in Marc).

In rare cases, a DDM analysis with segment-to-segment contact and the project stress-free option could
stop prematurely.

Solver - Restart/Model Section

MARC-17771

If a Marc data file uses the IMPORT SEC option as well as the USDATA option, then the analysis would
be terminated prematurely with exit number 24 if the imported Model Section does not include the

USDATA option.
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User Subroutine

MARC-17279 It is now possible to run Marc with user subroutines using the Intel oneAPI compiler environment.

MARC-17680 Results were incorrect if the post codes for velocity and acceleration are requested via user subroutines
IMPD and NODVAR in a harmonic analysis.
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Mentat

General
MARC-11742

MARC-17445

MARC-17684

Marc Reader
MARC-17326
MARC-17351

Marc Writer
MARC-12896

MARC-17755
Pre Processing
MARC-16685

MARC-17446

In rare cases, plotting trimmed surfaces in solid mode without lines could cause Mentat to terminate
prematurely.

The Sweep Nodes and Sweep All commands in the Geometry & Mesh > Sweep menu did not merge nodes
of RBE2's that are within tolerance of each other.

If an RBE3 is duplicated using the commands in the Duplicate, Symmetry or Expand menus, then the
copies of the nodes of the RBE3 were not assigned to the corresponding copies of the RBE3.

The Crack Specimen Length parameter (entered in the option CRACK DATA) could not be imported.

If a Marc input file is imported that contains multiple streamline regions with different number of
streamlines per region, then the number of edges/faces defining a region was not imported correctly, but
was set to the maximum number of edges/faces in any region. This did not affect the results of a subsequent
Marc job, unless the original input file also imports a model section file with a streamline region. In that
case, the results for model section could potentially be wrong.

In a thermal stress analysis where the temperature is read from a single increment of a post file, Mentat did
not write the correct data for the Change State option for load cases using the Auto Step option.

If the sixth component of the INHERENT STRAIN boundary condition is table dependent, then the
table ID was incorrectly exported to the Marc data file.

In rare cases, plotting trimmed surfaces in solid mode without lines could cause Mentat to terminate
prematurely.

The filters on the list of table variable types (Tables menu) and on the list of available result quantities (Job
Results menu) did not update the list automatically if the filter text is changed. The Apply button had to
be clicked to filter the list based on the modified text. The filters will now (re-)filter the list automatically
and immediately when the filter text is changed. The Apply buttons are no longer needed and have been
removed.

Thirdparty Import

MARC-17254

Following Abaqus keywords are supported now:
*VISCOELASTIC, TIME

*UNIAXIAL TEST DATA

*HYPERELASTIC, MARLOW
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List of Build and Supported Platforms - Marc 2021.2 Release

Marc Platforms

Linux (64 bit) RHEL 7.1/7.3/7.5/7.7 and Intel EM64T or AMD Opteron  Intel XE 19.04! Intel MPI 2019 Update 10

SUSE 12 SP1/SP2/SP4 Intel EM64T or AMD Opteron  Intel XE 19.04! Intel MPI 2019 Update 10
Windows (64- Windows 10 Intel EM64T or AMD Opteron  Intel XE 19.04! Intel MPI 2019 Update 92
bit) Windows Server 2016

1 When using user subroutines, Intel Fortran XE 19.04 must be installed. When using user subroutines on Windows, Microsoft Visual Studio 2017
must also be installed.

2 Supports also Microsoft MPI program version 9.0.

Mentat Platforms

Vendor 0S Hardware
Linux (64-bit) RHEL 7.1/7.3/7.5/7.7 and Intel EM64T or AMD Opteron
SUSE 12 SP1/SP2/SP4
Windows (64-bit) Windows 10 Intel EM64T or AMD Opteron
Windows Server 2016
All platforms support Python 3.6.

Mentat Graphics Card Support

The following graphics boards have been certified to work with the Mentat 2021.2 release:

Graphics Board Graphics Driver Version

AMD FirePro V4800 (FireGL V) 15.201.2401.0
AMD FirePro W4190M 21.19.142.32768
AMD Radeon Pro WX 4130 21.19.384.3
AMD Radeon Pro WX 4130 21.19.384.3
AMD Radeon Pro WX 4150 21.19.384.3
AMD Radeon Pro WX 7100 21.19.384.3
AMD Radeon Pro WX4150 16.40.3801.1002
AMD Radeon WX2100 22.19.640.2
AMD Radeon WX2100 22.19.640.2
AMD Radeon WX3100 22.19.640.2

AMD Radeon WX3100 22.19.640.2
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Graphics Board Graphics Driver Version

AMD Radeon Pro WX 3100
AMD Radeon Pro WX 3200
AMD Radeon WX4100
AMD Radeon WX4100
AMD Radeon WX4100
AMD Radeon WX5100
AMD Radeon WX7100
AMD Radeon WX9100
AMD Radeon WX9100
AMD Radon Pro WX3100
AMD Radon Pro WX3200
AMD Radon Pro WX4100
AMD Radon Pro WX5100
AMD Radon Pro WX7100
AMD Radon Pro WX8200
AMD Radon Pro WX9100
Nvidia Quadro M1200
Nvidia Quadro M1200
Nvidia Quadro M1200
Nvidia Quadro M2200
Nvidia Quadro M2200
Nvidia Quadro P1000
Nvidia Quadro P2000
Nvidia Quadro P2000
Nvidia Quadro P3000
Nvidia Quadro P3200
Nvidia Quadro P4000
Nvidia Quadro P4000
Nvidia Quadro P4000
Nvidia Quadro P5000
Nvidia Quadro P5000
Nvidia Quadro P5000
Nvidia Quadro P600

23.20.787.768
19.Q2
17.10.1730.1004
22.19.640.2
22.19.640.2
17.10.1730.1004
17.10.1730.1004
22.19.640.2
22.19.693.256
26.20.13028.13
26.20.13028.13
26.20.13028.13
26.20.13028.13
26.20.13028.13
26.20.13028.13
26.20.13028.13
21.21.13.7586
377.43

377.43
21.21.13.7586
377.43

377.11

377.11
23.21.13.8908
21.21.13.7586
23.21.13.8908
21.21.13.7586
377.11

385.69
21.21.13.7586
377.43

377.11

377.11



Marc and Mentat Release Guide 2021.2 | 19
List of Build and Supported Platforms - Marc 2021.2 Release

Graphics Board Graphics Driver Version

Nvidia Quadro P600 23.21.13.8908
Nvidia Quadro P6000 377.11

Nvidia Quadro P620 23.21.13.9077
Nvidia Quadro RTX 5000 25.21.14.1917
Nvidia Quadro RTX 6000 25.21.14.1917
Nvidia Quadro RTX 4000 25.21.14.1917
Nvidia Quadro P2200 26.21.14.3064
Nvidia Quadro T1000 25.21.14.2591
Nvidia Quadro RTX3000 25.21.14.2591
Nvidia Quadro RTX5000 25.21.14.2591

Peripheral Devices

3DCONNEXION’s SpacePilot PRO, SpaceMouse PRO and SpaceNavigator products, have been tested with Mentat. For
Linux based systems, see the Marc and Mentat: Installation and Operations Guide for additional information.
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Security Notes

The 2021.2 release requires the FlexLM 11.16 (Helium) server version and stores the license manager (Imgrd) by default
in the directory C: \Program Files\MSC.Software\MSC Licensing\Helium\lmgrd for Microsoft Windows and

for Linux platforms it is /msc/MSC.Software/MSC Licensing/Helium/lmgrd. The default location for the license
file is MSC Licensing/Helium.

The capabilities that require a license are given below with feature names as required in the license file.

1.

10.
11.
12.
13.
14.
15.

16.

17.

18.

MARC
MARC_Parallel
MARC_Mesh2D
MARC_Mesh3D

MARC_ShapeMemory
MARC_MetalCutting
MARC_Electrical

MARC_GPU
MARC_CASI
MARC_Hexmesh
MARC_MatFit
MARC_PhaseTrans

MARC_CoSim_Adaptor

Mentat
Mentat_Parasolid_ CAD

Mentat_Parasolid_Modeling

Mentat_ITI_Access

Mentat CMOLD

license required to run one single processor job or one instance of a
multiple processor (parallel) job.

license required per processor in a parallel run (either DDM, or parallel
element assembly and stress recovery, or parallel CASI).

license required for each run requiring automatic 2-D remeshing feature in

Marc.

license required for each run requiring automatic 3-D remeshing feature in
Marec.

license required for each run using shape memory model.
license required for each run modeling metal cutting operation.

license required for Joule-Mechanical, Coupled Electrostatic- Structural,
and Piezoelectricity.

license required to use the GPGPU solver capability.

license required to use the CASI iterative solver.

license required for each instance of Hexahedral mesher.

license required for advanced material data fitting.

license required for MICROSTRUCTURE phase transformation model.
license required to run a co-simulation analysis with MSC CoSim.
license required for each instance of Mentat.

license required for each instance of Parasolid when working
(import/export/meshing) with Parasolid based models. This license does
NOT allow the creation of solid geometry or the modification of solid
geometry through Booloean operations, blending, and/or feature
recognition and removal.

license required for each instance of Parasolid when working
(import/export/creation/modification/ meshing) with Parasolid based
models.

license required for each instance of, or exporting a file using the DXE,
IGES, or VDAES translators.

license required for each instance of CMOLD when working
(import/export) with CMOLD based models.



19.

20.

21.

22.

23.

24.

25.

26.

Mentat_Geometry_Translators
Mentat CATIAV4_Access
Mentat_ CATIAV5_Access
Mentat_Creo_Access
Mentat_Inventor_Access
Mentat_JT_Access

Mentat_ NX_Access

Mentat_SolidWorks_Access
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license required for import of Parasolid, IGES, IDEAS, ACIS, STEP, STL

to Parasolid Geometry with cleanup of model.

license required for import of CATIAV4 model to Parasolid Geometry with
cleanup of model.

license required for import of CATTIAV'5 model to Parasolid Geometry with
cleanup of model.

license required for import of Creo and Pro/E model to Parasolid Geometry
with cleanup of model.

license required for import of Inventor model to Parasolid Geometry with
cleanup of model.

license required for import of JT model to Parasolid Geometry with
cleanup of model.

license required for import of NX model to Parasolid Geometry with
cleanup of model.

license required for import of SolidWorks model to Parasolid Geometry
with cleanup of model.



	Marc and Mentat Release Guide
	Contents
	Chapter 1: Overview
	Introduction
	Overview of New Functionality
	Marc
	Mentat

	Changes to Initial and Boundary Conditions in Mentat
	List of Known Defects in the 2021.2 Release
	Marc
	Mentat

	List of Fixed Defects in the 2021.2 Release
	Marc
	Mentat

	List of Build and Supported Platforms - Marc 2021.2 Release
	Marc Platforms
	Mentat Platforms
	Mentat Graphics Card Support
	Peripheral Devices

	Security Notes




